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Agency Approvals
Required Safety Labels

Dolphin 7600 mobile computers meet or exceed the requirements of all applicable standards organizations for safe operation. 
However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency 
guidelines that follow. Please read these guidelines carefully before using your Dolphin mobile computer.

Location 

Regulatory and Safety Approvals for all Dolphin 7600 Terminals 

For further information, please contact:

Hand Held Products, Inc.
Nijverheidsweg 9
5627 BT Eindhoven
The Netherlands

Hand Held Products, Inc. shall not be liable for use of our product with equipment (i.e., power supplies, personal computers, etc.) 
that is not CE marked and does not comply with the Low Voltage Directive.

Dolphin 7600 Series WLAN (802.11b/g) or WPAN (Bluetooth) Radio

Dolphin 7600 RF terminals are designed to comply with the most current applicable standards on safe levels of RF energy 
developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute (ANSI) 
and has been recommended for adoption by the Federal Communications Commission (FCC). 

Required Safety Labels
The required safety labels that appears on the back of Dolphin 7900 terminals equipped with the following radios are as follows:

Parameter Specification

U.S.A
Canada
European Community

802.11b/g Bluetooth 802.11b/g and Bluetooth

Safety Label Radio Label
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FCC Compliance 

Dolphin mobile computers meet or exceed all applicable standards and have been manufactured to the highest level of quality. 

Dolphin 7600 Batch Terminal

Dolphin 7600 Batch terminals comply with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation.

Dolphin 7600 RF Terminal with an 802.11b/g and/or Bluetooth Radio
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause 
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user 
may find the following booklet helpful: “Something About Interference.” This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the 
substitution or attachment of connecting cables and equipment other than those specified by our company. The correction is the 
responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or 
transmitter. To maintain compliance with FCC RF exposure guidelines for body-worn operation, do not use 
accessories that contain metallic components. 

!
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RF, Regulatory, and Safety Agency Approvals for 802.11b/g and/or Bluetooth 

Dolphin 7600 802.11b/g and/or Bluetooth R&TTE Compliance Statement

Dolphin 7600 RF terminals are in conformity with all essential requirements of the R&TTE Directive (1999/5/EC). This equipment 
has been assessed to the following standards as applicable:

This product is marked with  in accordance with the Class II product requirements specified in the R&TTE 
Directive, 1999/5/EC. 

The equipment is intended for use throughout the European Community. Its authorization for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restrictions in France are as follows: 

• Indoor use - Maximum power (EIRP*) of 100 mW for the entire 2400-2483.5 MHz 
• Outdoor use - Maximum power (EIRP*) of 100 mW for the 2400-2454 MHz band and maximum power (EIRP*) of 10 mW for 

the 2454-2483 MHz band

Pacemakers, Hearing Aids and Other Electrically Powered Devices
Most manufacturers of medical devices adhere to the IEC 601-1-2 standard. This standard requires devices to operate properly 
in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. 

The maximum allowable field strength emitted by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. 
Therefore, the Dolphin RF has no effect on medical devices that meet the IEC specification. 

Microwaves
The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven. Therefore, if you use a 
microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, 
both your microwave and your wireless network will continue to function.

The Dolphin Batch terminal does not contain a radio, and therefore, is not affected by microwave ovens.

Canadian Compliance for Dolphin 7600 Terminals with an 802.11b/g and/or Bluetooth 
Radio

This Class B digital apparatus complies with Canadian ICES-003. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation. 

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to 
provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

Parameter Specification

RF Approvals
U.S.A
Canada

Parameter Specification

R&TTE
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For European Community Users

Hand Held Products complies with Directive 2002/69/EC OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL of 27 
January 2003 on waste electrical and electronic equipment (WEEE).

Waste Electrical and Electronic Equipment Information

This product has required the extraction and use of natural resources for its production. It may contain hazardous substances 
that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, 
we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of 
the materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed of along with municipal waste 
and invites you to use the appropriate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste 
administration.

You may also contact your supplier for more information on the environmental performances of this product.
1 - 4 Rev (a) Dolphin® 7600 Series User’s Guide
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Getting Started
Out of the Box
Verify that your carton contains the following items: 

• Dolphin 7600 mobile computer (the terminal)
• Main battery pack (3.7v, Li-ion)
• AC power supply
• Localized plug adapters 
• User CD

Note: Be sure to keep the original packaging in case you need to return the Dolphin terminal for service; see see Product Service 
and Repair on page 11-1. 

Step 1. Install the Main Battery    

Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products 
in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.!
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Step 2. Charge the Batteries

Step 3. Boot the Terminal 

Windows CE

The terminal begins booting as soon as power is applied and runs by itself. Do NOT press any keys or interrupt the boot process. 

When the boot process is complete, the Desktop appears and the terminal is ready for use. 

Windows Mobile

The terminal begins booting as soon as power is applied and runs by itself. Do NOT press any keys or interrupt the boot process. 
Only tap the screen when prompted.

When the boot process is complete, the Desktop appears and the terminal is ready for use.   

Using the Stylus

The terminal comes with a stylus inserted into the Stylus Slot (see page 3-4), Use this stylus (or your finger) to select or enter 
information on the touch screen. The stylus functions as a mouse; generally, a tap is the same as a click.

Tap Tap the touch screen once to open menu items and select options.

Drag Hold the stylus on the screen and drag across the screen to select text and images.

Tap & hold Tap and hold the stylus on an item and a pop-up menu appears. On the pop-up menu, tap the action 
of the task you want to perform.

Use of other objects other than the stylus, such as paper clips, pencils, or ink pens can damage the touch screen and will 
void the warranty.

For more information about the touch screen see Touch Screen Display on page 3-2.

2

1
Dolphin terminals ship with both the main battery 
pack and internal backup battery significantly 
discharged of power. Charge the main battery pack 
with the Dolphin charging cable for a minimum of 
four hours before initial use.

1. Attach the appropriate plug adapter to the plug 
of the power cable.

2. Plug the *power cable into the DC Power Jack 
(see page 3-5) on the left side. 

3. Insert the plug into the appropriate power 
source.  

Use only the peripherals, power cables, and 
power adapters from Hand Held Products. 
Use of peripherals, cables, or power adapters 
not sold/manufactured by Hand Held 
Products will void the warranty and may 
damage the terminal.

*This power cable can also be used to power the 
Dolphin HomeBase (see page 9-1).

!

!
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Desktop

System resets (see Resetting the Terminal on page 3-14) end on the Desktop. 

Note: You can access the Desktop any time by tapping the Desktop screen at any time by double-tapping the Desktop icon in 

the command bar .

Command Bar

Located at the bottom of application screens, the command bar includes application menus, buttons, and provides access to the 
Input Panel.

Icons in the Command Bar
The Command Bar (see page 2-3) contains a number of icons that indicate the status of various functions on the terminal.

Status Icon Meaning

Icons Between the Arrows

Because there may be more icons than the device can display, use the left and right arrows to scroll through the 
icons. 

The Bluetooth radio is installed and enabled. Tap this icon to open the Bluetooth Radio Manager; for 
details, see Bluetooth Manager on page 7-1.

The communication cable is connected. Tap to see the status of the cable or disconnect it.

Tap to open the keyboard

Tap to change the date and time

Tap to return to the Desktop or 
toggle between open applications.

This area displays various icons 
that access applications running 
on the device. Use the right and 
left arrows to navigate through 
these icons.

Tap to access the Start menu.
Dolphin® 7600 Series User’s Guide -
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Selecting Programs

Tap Start > Programs. To open a program, double-tap the icon.

Indicates the status of battery power. This icon means that the battery is low. Tap this icon to open the 
Power control panel setting. 

Indicates that the device is running on external power. 
Tap this icon to open the Power control panel setting. 

HOW DO YOU TURN THE BEEPER ON AND OFF??

WHAT ARE THE INDICATORS OF THESE BATTERY STATES?

Tap this icon to open the soft input panel (SIP) manually.

This icon appears when the SIP is open, whether the SIP was opened manually or automatically 
popped up on an application screen. Tap this button and select Hide Input Panel on the menu that 
pops up when you want to close the SIP.

Synchronization is beginning or ending
???????????????????

Notification that one or more e-mail messages were received
???????????????????
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Pop-Up Menus

With pop-up menus, you can quickly choose an action for an item.  

1. Tap and hold the stylus on the item name. The pop-up menu appears.

2. Lift the stylus, and tap the action you want to perform. 

The contents of pop-up menus depend change according to the program you’re in.

Using Windows Explorer

Use Windows Explorer to navigate through the files on your system.

The fastest way to open Windows Explorer is from the Desktop. Double-tap the My Device icon  and Windows Explorer 
opens to the root level, 

Move files by tapping and holding on the file, then tapping Cut, Copy or Paste on the pop-up menus that appear.
Dolphin® 7600 Series User’s Guide -
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Hardware Overview
The Dolphin 7600 includes a number of standard terminal configurations as well as charging and communication peripherals and 
accessories to maximize the efficiency of your application setting.

Standard Terminal Configurations

The standard Dolphin 7600 terminal configuration is:

• Microsoft Windows CE
• Samsung 2440 400 MHz
• 64MB RAM X 128 MB ROM (non-volatile) Memory
• 29-key numeric keyboard
• 2.8” 1/4 VGA TFT color display
• Li-ion battery 3.7V / 2200 mAh / 8.1 Wh
• 5300 or 5100 Standard Range (SR) image engine
• Bluetooth radio (WPAN)
• Dolphin power cable (each Dolphin 7600 device comes with a power cable)

Additional Configuration Options
The Dolphin 7600 offers you a number of configuration options to customize the Dolphin 7600 terminal to your business needs.

Radio Options You can add an 802.11b/g radio; see WLAN Manager–802.11b/g on page 8-1.

Battery Power You can use a more powerful Li-ion battery: 3.7V / 3240 mAh / 12.0 Wh.

Care and Cleaning of the Dolphin Terminal

When needed, clean the image engine window and the LCD display with a clean, non-abrasive, lint-free cloth. The terminal can 
be cleaned with a damp cloth.
phin® 7600 Series User’s Guide -
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Front Panel Features

Scan LED

The Scan LED lights red when you press the Scan trigger in scanning applications.

Decode LED

The Decode LED lights green when a scanned bar code is successfully decoded.

Note: Both LEDs are user-programmable.

Microphone

The integrated microphone can by used for voice-recording only. (No voice communication function.)

Keyboard

The 29-key keyboard is are recessed under the overlay to increase durability. For complete information about the 
keyboard as well as specific keys called out here, see Using the Keyboard on page 4-1.

Touch Screen Display

The display is a 65,536-color LCD (Liquid Crystal Display) covered by an industrial touch screen lens. The 2.8” (1/
4) VGA (Video Graphic Array) is TFT (Thin Film Transistor) color, backlit, and the resolution is  240 x 320. For 
information about the backlight for the display, see Backlight on page 6-7.

Dolphin 7600 devices ship with a screen protector already installed over the touch screen lens to help prevent 
damage to the touch screen. Do NOT remove this screen protector before initial use. Hand Held Products 
recommends using screen protectors, especially for applications that require high-volume interfacing with the 
touch screen. 

For touch screen input, use the stylus included with the terminal or your finger. The method you choose depends 
on which one is most appropriate for your application. While there is a great deal of variation in different applications, 
for buttons or icons that are close together, you generally achieve greater accuracy with the stylus; see Using the 
Stylus on page 2-2.

Scan LED Decode LED

1/4 VGA Touch 
Screen Display

Keyboard

Scan key

Backlight & 
Power key

Microphone

!
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Use of objects, such as paper clips, pencils, or ink pens on the touch screen can damage the input panel and 
will void the warranty. !
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Back Panel Features

Accessory Attachment

This button protruding from the back panel can you used with various accessories; see Using the Accessory 
Attachment on page 3-9.

Finger Saddle

This is a slightly depressed and angled area of the back panel that is designed to cradle or “saddle” your pointer 
finger while holding the terminal. This unique ergonomic design makes the terminal comfortable to hold and helps 
prevent you from accidentally dropping the terminal.

Installed Battery

The back of the battery pack conforms to the back panel. 
For information about installing the battery, see Changing the Main Battery Pack on page 3-11.
For information about battery power, see Battery Power on page 3-11.

Speaker

The integrated speaker sounds audio signals as you scan bar code labels and enter data but is muted on system 
activity (i.e. processor, memory access, radio traffic, etc.). The speaker can also be used for playing sounds (e.g., 
WAV or MP3 files). By default, the speaker volume is set to Max.

The speaker meets the following operating frequency range is 500Hz at 71 dB up to 80 dB and meets the following 
SPL levels at 40 centimeters:

• 500Hz - 67db
• 1KHz - 72db
• 4KHz - 72db

Stylus Slot

Dolphin 7600 terminals ship with a stylus inserted. Stores the stylus in this slot when you’re not using it; see Using 
the Stylus on page 2-2.

Speaker

Stylus Slot

Installed 
Battery

Finger Saddle

Accessory Attachment

Image Engine Window

I/O Connector
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Side Panel Features

Note: This graphic shows the left side of the Dolphin 7600 terminal.

Side Button

Programmable buttons are located on both side panels. By default, these buttons activate the image/scan engine 
as a more ergonomic alternative to pressing the SCAN key on the keyboard. These buttons can be programmed to 
perform specific functions in the Buttons setting.

THIS IS HOW THE 7900 BUTTON FUNCTIONS. TRUE FOR THE 7600? WILL THERE BE A BUTTONS 
SETTING?

Headset Jack

This is a 2.5mm audio jack that supports both speaker (stereo) and microphone (mono) headsets. 

WILL THERE BE A HEADSET JACK CONTROL PANEL APPLET??

DC Power Jack

The DC power jack receives external power from the Dolphin power cable that comes in the box with the terminal. 
When connected to the Dolphin Power Cable, the terminal is powered and the main battery pack is charging.

For more information,  about the Dolphin power cable, see Charge the Batteries on page 2-2.

IrDA Port

The IrDA (Infrared Data Association) port communicates with IrDA-enabled devices such as PCs, printers, 
modems, or other Dolphin 7600 terminals. Maximum data transfer speed is 115 Kbps. For more information, see 
Using Infrared???? on page 6-10.

Side Door

WHAT DO WE WANT TO SAY ABOUT THE SIDE DOOR? IF ANYTHING?

IrDA PortSide 
Button

Headset 
Jack

DC Power 
Jack

Side Door
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Top Panel Features 

*Pull the plastic tab to remove the plastic film cover over the image engine window before activating the image engine.

Access Door

The terminal comes loaded with 64MB of on-board RAM (volatile) memory and 128MB ROM (non-volatile) memory 
for persistent storage. For more memory, you can install memory cards by removing this door. For details, see 
Dolphin 7600 Peripherals on page 3-10.

Image Engine Window

The angled image engine reads and decodes most popular bar code symbologies and takes images like a digital 
camera. For more information, see Using the Image Engine on page 5-1.

Installing Memory Cards

The Dolphin 7600 supports Secure Digital (SD) memory cards of the following capacities:

• 16 MB 
• 32 MB 
• 64 MB 
• 128 MB 
• 512 MB 
• 1 GB 
• 2 GB 

To install an SD card, you must open the access door on the top panel (Top Panel Features, page 3-6).

Note: The screws Access door removal requires a phillips screwdriver.

1. Press Blue + Backlight key to put the terminal in suspend mode; see Suspend Mode on page 3-14.

2. Place the terminal on a flat, secure surface with the keyboard face-up.

Image Engine Window 
(with engine)

Access Door
3 - 6 Rev (a) Dolphin® 7600 Series User’s Guide
-Second Draft Preliminary



3. Unscrew both screws on the access door.

4. When the access door is open, slide the mini-SD card into the appropriate slot until it clicks into place.

To remove an installed mini-SD card, tap on the edge lightly to unlock the card; the card will pop out just enough 
for you to grab its edge and pull it out.

5. Replace the access door and tighten the screws.
There is a rubber gasket on the inside of access door that must be in place when you seal the door. This gasket performs 
the sealing action for the door.

6. Tap the Blue + Backlight keys to resume operation.

Do NOT resume terminal operation while the access door is open! Operating the terminal while the access door is open 
will void the warranty.When closed, the access door seals the memory interface from moisture and particle intrusion thus 
preserving the terminal’s environmental rating. The access door must be properly sealed before resuming terminal 
operation. Failure to seal the access door will void the warranty.

7. To verify that the operating system recognizes the new memory card, tap Start > Settings > Control Panel > System > 
Memory tab.

Rubber Gasket

!
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Bottom Panel Features

I/O Connector

This custom mechanical connector is designed to work exclusively with Dolphin 7600 peripherals and cables. This 
connector powers the terminal, charges the main battery, and facilitates communication. This connector supports  
full speed USB 1.1 communication (up to 12 Mbps) and RS-232 communications with a maximum speed of 
115Kbps and seven baud rate settings.

Through this connector, you can communicate with a host workstation via Microsoft ActiveSync; see ActiveSync 
Communication on page 6-4.

Pin Table

The pins on the I/O connector are as follows: 

Note: Signals referenced are for a DTE device.

Hand Strap Slot

There is an adjustable, elastic hand strap available for purchase with the Dolphin 7600 terminal. When installing the 
hand strap, you loop the elastic strip through this slot. For instructions, see Attaching the Hand Strap on page 3-9.

Pin Description

1 Data Carrier Detect

2 Received Data

3 Transmitted Data

4 Data Terminal Ready

5 Signal GND

6 Data Set Ready

7 Request To Send

8 Clear To Send

9 Ring Indicator

I/O Connector Hand Strap Slot
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Using the Accessory Attachment

The accessory attachment is a standard tab designed to fit universal accessories available for most cell phones.

Attaching to a Belt Clip

Attaching the Hand Strap
The accessory attachment can also be used to attach the Dolphin 7600 hand strap available from Hand Held Products.

Keep in mind that the hand strap covers the battery. When you want to replace the battery, you will need to adjust the hand strap 
accordingly.

The accessory attachment on the back panel fits universal swivel clips designed for belts 
or even pedestal mounts (not available from Hand Held Products). 

Simply insert the tab into the slot until you hear a click or follow the instructions that came 
with the clip or accessory
Dolphin® 7600 Series User’s Guide -
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Dolphin 7600 Peripherals 

The following items are sold separately and enhance your Dolphin 7600 terminal’s capabilities. 

Dolphin HomeBase™

The Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communication, enabling your 
terminal to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its main 
battery pack charges in less than four hours. 

For more information, see Dolphin HomeBase on page 9-1.

Dolphin QuadCharger™ 
The Dolphin QuadCharger is a four-slot charging station for Dolphin Li-ion battery packs that can charge each battery in less than 
four hours. The fourth slot features a battery analyzer that completely resets and re-calibrates a battery, then displays remaining 
capacity. 

For more information, see Dolphin QuadCharger on page 10-1. 

Dolphin 7600 Accessories

Each of the following items is sold separately to enhance your Dolphin 7600 terminal’s capabilities.

Protective Enclosure

This enclosure wraps around the terminal to protect it from wear and tear.

Protective Holster

The protective holster holds the terminal for mobile use.

Li-ion Battery Packs 

The available Li-ion battery packs provide the main power supply for the terminal. For more information, see Battery Power on 
page 3-11.
3 - 10 Rev (a) Dolphin® 7600 Series User’s Guide
-Second Draft Preliminary



Battery Power

The Dolphin 7600 features intelligent battery technology with two types of battery power: 

• The main battery pack on the back panel (see Installed Battery on page 3-4)
• The backup battery located inside the terminal

Both batteries work together to prevent data loss when the terminal is used over long periods of time. 

Both batteries must be charged to full capacity before using the Dolphin 7600 for the first time! Initial charge time for the 
main battery pack is four hours. Initial charge time for the internal backup battery is eight hours.

Main Battery Pack
Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

There are two Li-ion battery packs available for the Dolphin 7600:

Standard Li-ion 3.7V/2200mAh/8.1Wh

Optional Li-ion 3.7V/3240mAh/12.0Wh 

The Li-ion battery packs are the primary power source for the Dolphin terminal as well as the internal backup battery. The Li-ion 
battery is designed to operate in a temperature range of -10 to 50° C (14 to 122° F).

Changing the Main Battery Pack
Before installing a battery pack, press and hold the Blue + Backlight keys to put the terminal in Suspend Mode (see page 3-14) 
so that operations are suspended before removing the main power source. Always put the terminal in suspend mode prior to 
changing the battery.

Charging Options
When the battery is installed in the terminal, you can insert the terminal into any one of the following peripherals:

• Dolphin HomeBase (see page 9-1)
• Dolphin Charge/Comm Cable (see page 13-1)
• Dolphin Power Cable (see page 13-1)

To fully charge the Li-ion battery before installing it in the terminal, use the 

• Dolphin QuadCharger (see page 10-1)

Charging Time
The Li-ion battery pack requires four hours to charge to full capacity.

Internal Backup Battery
Located inside the terminal, the backup battery is a 3.6V nickel metal hydride 
(NiMH) battery. 

The internal backup battery prevents the terminal from being reset when you remove the main battery pack. The backup battery 
retains RAM data and allows the real-time clock to remain operational for up to 30 minutes. If the terminal is left without the main 
battery pack for more than 30 minutes, the internal backup battery discharges and needs to be recharged to function according 
to specifications.  

Note: Even if the internal backup battery fails, data and programs stored in Flash memory are not totally lost. However, the 
terminal automatically cold boots when you install a fully charged battery pack and you need to reset the real-time clock.

Charging
The internal backup battery is powered by the main battery pack and must be fully charged before using the terminal for the first 
time. It takes approximately eight hours to fully charge the internal backup battery the first time. After that, if the internal backup 
battery is ever fully discharged, it takes 10 hours to recharge.

!
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Guidelines 
Follow these guidelines to maximize the life of the Dolphin’s internal backup battery:

• Keep a charged Li-ion battery pack in the Dolphin terminal. 
• Keep the Dolphin terminal connected to a power source when the terminal is not in use. 

Managing Battery Power
Data and files saved on the Dolphin terminal may be stored in RAM memory; therefore, maintain a continuous power supply to 
the terminal to help prevent data loss. When you remove a battery pack, insert another charged battery pack in the Dolphin. If 
the main battery pack is low, insert the terminal into a charging peripheral to power the terminal and begin recharging the battery.

Note: If the main battery is low and the terminal is in suspend mode, pressing the SCAN button does not wake the Dolphin 
terminal; you must replace the discharged battery with a fully charged battery.

Default Low and Critical Battery Points
The command bar at the bottom of the each screen displays battery warning icons when the main battery reaches low and critical 
battery points. 

The Dolphin terminal ships with default low and critical battery points already programmed in the registry:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power]
Note: Battery power warnings do not appear when the terminal is running on external power.

Setting Critical and Low Battery Points
Developers can re-reset the default battery points in the RegEdit Power Tool. 

1. Tap Start > Power Tools > RegEdit?????. 

2. Drill-down to HKEY_LOCAL_MACHINE > System > CurrentControlSet > Control > Power. The CriticalBatt and LowBatt 
values appear in the list.

3. Tap the Value Name to change the Value Data. You can reset the Value Data from 0 (no warning) to 99 (would warn 
whenever the charge drops below 99%). 

4. Tap OK to save changes.

Note: For more information about the RegEdit Power Tool, refer to the Dolphin Power Tools User’s Guide, which is available for 
download at www.handheld.com.

Checking Battery Power
Power icons appear in the command bar at the bottom of the window. Double tap on this icon at any time to open the Power 

system setting. For example,  indicates a low battery.

You can also tap Start > Settings > Control Panel tab > Power. 
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In either case, the Battery tab opens displaying the charge status of both the main and backup batteries.   

For more information, see Power on page 6-11.

Storage Guidelines
To maintain optimal battery performance, follow these storage guidelines:

• Avoid storing batteries outside the specified range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

Guidelines for Battery Use and Disposal
The following are general guidelines for the safe use and disposal of batteries:

• Use only the battery supplied, recommended, or approved by Hand Held Products. 
• Replace defective batteries immediately; using a defective battery could damage the Dolphin terminal.
• Never throw a used battery in the trash. It contains heavy metals and should be recycled according to local guidelines. 
• Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.
• Excessive discharge damages a battery. Recharge the battery when your terminal indicates low battery power.
• Although your battery can be recharged many times, it will eventually be depleted. Replace it after the battery is unable to 

hold an adequate charge.
• If you are not sure the battery or charger is working properly, please send it to Hand Held Products or an authorized Hand 

Held Products service center for inspection.
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Resetting the Terminal

There are two ways to reset the Dolphin terminal: a soft reset and a hard reset. 

Soft Reset (Warm Boot)
A soft reset re-boots the device without losing RAM data. You would perform a soft reset 1) when the terminal fails to respond, 
2) after installing software applications that require a reboot, or 3) after making changes to certain system settings.

1. Press and hold RED  + ESC  for approximately 5 seconds. The screen turns white and the decode and scan 
LEDs flash for approximately three seconds. 

2. When the reset is complete, the Desktop appears.

Hard Reset (Cold Boot)
A hard reset erases all of the data and applications stored in RAM memory and launches Autoinstall, which re-initializes the 
terminal.

1. Press and hold RED  + TAB  for approximately 5 seconds. The screen turns white and the decode and scan LEDs 
light for approximately three seconds. 

2. The terminal re-initializes. This includes running Autoinstall, which re-installs all programs stored in the \IPSM\Autoinstall 
folder. 

Note: Hard resets automatically launches a soft reset as part of the boot process.

Note: Set the time and date after each hard reset to ensure that the system clock is real-time. Tap the date on the command 
bar to open the Clock setting and set the time and date. 

Suspend Mode 

Suspend mode suspends terminal operation. The terminal appears to be “off” when in suspend mode.

The terminal is programmed to go into suspend mode automatically when inactive for a specified period of time. You can set this 
time period in the Power setting. For details, see the Advanced Tab section of the Power (see page 6-11) setting.

To Put the Terminal in Suspend Mode

Press and hold the Blue  + Backlight  keys.  

Note: You should always put the terminal in suspend mode when you change the battery pack; see Changing the Main Battery 
Pack on page 3-11.

To Resume Terminal Operation
To resume terminal operation (or “wake” the terminal), 

• Press and hold the Blue  + Backlight  keys.

• Press the Scan key .

Troubleshooting Suspend/Resume
If the terminal does not wake when you press the scan trigger,

!
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• The battery door may not be fully closed. The mechanical switch in the battery door prevents the terminal from resuming 
operations unless the door is closed.

• The main battery might be too low to resume operations. Remove the battery and install a fully charged battery or connect the 
terminal to a Dolphin charging peripheral.
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Dolphin 7600 Technical Specifications

Operating System Microsoft Windows CE 5.0

CPU Samsung 2440 400 MHz

Memory 64MB RAM X 128MB Flash; 128MB RAM option

Mass Storage SD Flash memory expansion slot – user accessible

Display 2.8” 1/4 VGA 240x320 TFT color display

Image Engine 5300 VGA Area Imager with High-Vis bracket aimer

Keypad 29-key numeric–shifted alpha

Sound/ Voice Speaker, microphone and headset compatible

Communications RS232/USB connector, IrDA port

Power Li-ion battery 3.7V / 2200 mAh / 8.1 Wh (standard)
Li-ion battery 3.7V / 3240 mAh / 12.0 Wh (optional)
Full Shift operation

Charging 5.0V DC input through side access or USB/Serial connector

Charging Peripherals AC wall adapter, Charge/Communication Cable, single bay HomeBase, battery Quad 
Charger

WPAN (standard) Bluetooth Class 2, version 1.2

WLAN (optional) 802.11b/g WiFi compliant  

WLAN Security WEP, 802.1x, WPA, WPA-PSK, TKIP, PEAP, TLS, others TBD before product release

Co-Located/Operational Two radios:  WLAN / WPAN

Operating Temperature Standard configuration: 14–122°F / -10–50° C

Construction High impact resistant PC/ABS housings Magnesium alloy internal chassis with component 
shock mounts

Structural 4’ (1.2m) multiple drops to concrete, all axis, across operating temperature range

ESD Air +/- 12k Vdc
Direct +/- 8k Vdc

Environmental IP54 rating

Dimensions 7.0” L x 2.7” W x 1.8” D (178 x 69 x 45 mm) 

Weight Approximately 11.7 oz  / 332 g
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Using the Keyboard
Overview

The 29-key numeric-shifted-alpha keyboard buttons are recessed under the overlay for maximum durability. The keyboard panel 
is backlit for maximum viewability in various lighting conditions.

29-key Keyboard  

Color-Coding
Keyboard overlays are color-coded to indicate the functions performed or characters typed when the color-coded key is pressed 
with the red or blue modifier key; see Modifier Keys on page 4-3. 

Key Types
In addition to the standard number and letter keys, both keyboards contains three types of keys:

1. Programmable Keys (see page 4-1)

2. Function Keys (see page 4-2)

3. Navigation Keys (see page 4-3) 

4. Modifier Keys (see page 4-3)

Programmable Keys

DO WE HAVE ANY INFORMATION ABOUT THESE? HOW TO PROGRAM THEM? (BUTTONS SETTING?)WHAT 
WE’RE CALLING THEM? WHAT ARE THE DEFAULTS?

SCAN

P G

P G

.

GHI

PQRS

S T A R T

TUV

JKL

ABC

WXYZ

MNO

DEF

Power

Backlight

Modifier Keys

Escape

Navigation Keys
Tab Shift

Enter

Scan
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Function Keys

Function keys are those keys that perform specific functions and usually have the name of the function they perform.

Name Key Function

Backlight Toggles the keyboard backlight on and off.

Backspace 
(BKSP)

To backspace, press Red + left arrow.
Backspace moves the cursor back one space and deletes each time the key combina-
tion is pressed. If you are typing text, a character is deleted each time you backspace.

Backtab
(BKTAB)

To backtab, press the Red + TAB.
Backtab moves the cursor back to the previous tab stop or field (on a form or applica-
tion window).

Delete 
(DEL)

????? To delete, press Blue + ESC. 
Deletes the next character forward. One character is deleted each time the key combi-
nation is pressed.

Escape Cancels an action.

Enter
(ENT)

Functions as an Enter key. 

Power Suspends or resumes terminal operation. 

Scan Activates the image engine to scan a bar code or take an image.

Shift
(SFT)

Provides shift functionality for application windows.
Tap once to modify the next letter pressed.
Tap twice for caps lock.

Space (SP) To space,  press Red + right arrow. Space moves the cursor one space forward. If you 
are typing text, it moves the text one space forward as well.

Tab Moves the cursor to the next tab stop or field (on a form or application window).

SCAN
4 - 2 Rev (a) Dolphin® 7600 Series User’s Guide
-Second Draft Preliminary



Navigation Keys

Located in the center of each keyboard for easy access with either hand, the navigation keys enable you to navigate the cursor 
through an application screen.

Note: Other functionality varies according to the application in use.

Modifier Keys

Modifier keys modify the next key pressed to perform functions or type special characters. The Dolphin 7600 has blue and red 
modifier keys with a color-coded overlay so you can see what the key combination does. 

Key Description

Move the cursor up one row or line.
Move the cursor down one row or line.

Volume up or 
down.

Scroll page up or 
down.

Move the cursor one character to the right.

Move the cursor one character to the left.

Name Key Function

Blue and
Red 

Modifies the next key pressed. The overlay of each keyboard is color-coded to indicate the 
character typed or function performed with both keys.
See Blue Key Combinations on page 4-5.
See Red Key Combinations on page 4-6. 

PG

PG

PG

PG
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Toggling Between Alpha and Numeric Modes??????????????????

The 29-key keyboard defaults to numeric mode. Numeric mode is when you type numbers with the number keys. Alpha mode is 
when you type letters or characters with the number keys. There are blue alpha indicators on the number buttons that specify 
the letters or characters typed when you press that key in alpha mode. 

• Double-tap the Blue modifier key to toggle between alpha and numeric modes.
• Single-tap the Blue modifier key to toggle to alpha or numeric mode only for the next key pressed. The keyboard returns to 

the previous state before the next key pressed.
• Press and hold the Blue modifier key to toggle to alpha or numeric mode for all keys pressed until the Blue modifier key is 

released.

Alpha Mode 
Please note that when typing in alpha mode, you must use the same multi-press method you would use when typing letters on 
a phone keypad. Each key press types the next letter in the sequence as displayed by the alpha indicator.

You can still use the Blue modifier key for regular Blue key combinations in alpha mode; just press and hold Blue modifier key 
with the next key in the combination. For combinations, see Blue Key Combinations on page 4-5. 

Shift Functionality in Alpha Mode

The SFT key performs all the normal windows shift key functions alpha mode, including capitalizing one letter. On the 25-key 
keyboard, the SFT key also toggles caps lock on and off.

• Single-tap the SFT key to modify the next key pressed; if this is a letter, that letter is capitalized.
• Double-tap the SFT key to toggle caps lock on and off in alpha mode.
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Blue Key Combinations

Alpha Mode 

Double-tap the Blue modifier key to switch to Alpha mode.    

Functions

Press the Blue key once in combination with the next key.

Key Character
Lower case

Character
Upper case:
SFT once for the next key
SFT twice for caps lock

1 @?!

2 abc

3 def

4 ghi

5 jkl

6 mno

7 pqrs

8 tuv

9 wxyz

0 Start menu

Key Combination Function

Blue + Backlight 
Suspend/Resume

Blue + ESC Delete

Blue + Tab Backtab

Blue + Up Arrow Volume up

Blue + Down Arrow Volume down

Blue + Right Arrow Insert
Dolphin® 7600 Series User’s Guide -
Second Draft Preliminary

Rev (a) 4 - 5



Red Key Combinations

Key Combination Function/Special Character

Red + Left Arrow

Red + Right Arrow

Red + Up Arrow Page up

Red + Down Arrow Page down

Red + ESC (hold) Soft reset (warm boot)

Red + TAB (hold) Hard reset (cold boot)

Red + 1 F1

Red + 2 F2

Red + 3 F3

Red + 4 F4

Red + 5 F5

Red + 6 F6

Red + 7 F7

Red + 8 F8

Red + 9 F9

Red + BKSP *

Red + 0 F10

Red + SP #

Red + . ,
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Using the Image Engine
Overview

The Dolphin 7600 terminal houses a compact image engine using Adaptus Imaging Technology™ that instantly reads all popular 
1D and 2D bar codes and supports omni-directional aiming and decoding. The image engine can also capture digital images, 
such as signatures and pictures of damaged inventory.

The image engine is angled downward.

Available Image Engines

Dolphin 7600 terminals may be equipped with one of the following image engines:

• 5100 Standard Range (5100SR)
• 5300 Standard Range (5300SR)

Depth of Field 
The depth of field specifications for the available image engines are as follows:  

Code  8 mil Linear 10 mil 
PDF417

13 mil UPC 15 mil QR 15 mil Data 
Matrix

35 mil 
MaxiCode

Working 
Range

(.020 cm) (.025 cm) (.033 cm) (.038 cm) (.038 cm) (.089 cm)

Near 3.4 in. (8.6 cm) 3 in. (7.6 cm) 2 in. (5.1cm) 3 in. (7.6 cm) 2.2 in. (5.6 cm) 1.9 in. (4.8 cm)

Far 7.5 in. (19 cm) 8.9 in. 
(22.6 cm)

13.1 in. 
(33.3 cm)

8.7 in. (22 cm) 10.1 in. 
(25.6 cm)

12.9 in. 
(32.7 cm)
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Supported Bar Code Symbologies

The Dolphin 7600 image engines support the following bar code symbologies: 

Symbology Type Symbology Name

1D Symbologies Codabar 
Code 3 of 9
Code 11
Code 32 Pharmaceutical (PARAF) 
Code 93 
Code 128 
EAN with Add-On
EAN with Extended Coupon Code 
EAN-13 
Interleaved 2 or 5 

Matrix 2 of 5 
Plessey 
PosiCode
RSS 
Straight 2 of 5 IATA
Straight 2 of 5 Industrial
Telepen 
Trioptic Code
UCC/EAN-128
UPC and UPC-A

2D Symbologies Aztec
Code 16K
Composite
Data Matrix
MaxiCode
OCR
PDF417
QR Code
RSS 

Composite Codes Aztec Mesa
Codablock F
EAN·UCC
RSS-14

OCR OCR-A 
OCR-B

Postal Codes Postnet and most international 4 state codes 
Australian Post
British Post
Canadian Post
China Post 
Japanese Post
KIX (Netherlands) Post 
Korea Post
Planet Code
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Activating the Engine

To activate the image engine, press the Scan key (see page 3-2) . You can also press one of the side buttons (see 
Side Button on page 3-5), which are programmed to activate the image engine by default.

Using Demos
Dolphin Demos are software utilities loaded on all Dolphin terminals that demonstrate the advanced features of the terminal. 
There are two Demos feature the image engine: Image Demo and Scan Demo.

To access these demos, tap Start > Demos,

• Select Image Demo to verify imaging, or
• Select Scan Demo to verify decoding.

For more information about Demos, refer to the Dolphin Demos User’s Guide, which is available for download from 
www.handheld.com.

LEDs
The LEDs in the center of both keyboards (for location, see LEDs on page 4-1) light when using the image engine.

Scan LED The LED on the left lights red when you press the scan trigger in scanning applications.

Decode LED The LED on the right lights green when a scanned bar code is successfully decoded.

Decoding

The Dolphin terminal supports two types of image decoding: full-area imaging and Advanced Linear Decoding (ALD).

Full-area Imaging

Full-area imaging means that the Dolphin terminal support omni-directional aiming, which means that a positive 
read can be obtained from many positions. For details, see Omni-Directional Scanning Positions on page 5-4. 

ALD

ALD provides fast reading of linear (1D) and stacked linear bar codes (PDF417). For the best read, the aiming 
pattern should be centered horizontally across the bar code. When ALD is enabled, the reader does not read matrix 
or postal codes.

To Decode a Bar Code
1. Tap Start > Demos > Scan Demo.

2. Position the Dolphin terminal over one of the sample bar codes on page 5-4.
A range of 4-10 inches (10-25 cm) from the bar code is recommended. 

3. Project the aiming pattern by pressing and holding the Scan trigger. The Scan LED lights red.

4. Center the aiming beam over the bar code. The aiming beam should be oriented in line with the bar code to achieve optimal 
decoding; Omni-Directional Scanning Positions, page 5-4

5. Release the Scan trigger.

6. When the bar code is successfully decoded, the decode LED lights green and the terminal beeps.

SCAN
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Sample Bar Codes
You can use the following bar codes to verify decoding:

Omni-Directional Scanning Positions
 The high-vis aiming pattern frames the bar code to provide you with the best scanning performance. 

Note: To achieve the best read, the aiming beam should be centered horizontally across the bar code. 

The aiming pattern is smaller when the terminal is held closer to the code and larger when the terminal is held farther from the 
code. Symbologies with smaller bars or elements (mil size) should be read closer to the unit whereas larger bars or elements 
(mil size) should be read farther from the unit.

Laser Engines
Laser engines do not support omni-directional scanning. To achieve an optimal scan, center the red aiming beam across the bar 
code horizontally as shown.

Sample 128 Sample PDF417

Code 128 PDF417 Test Message
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Capturing Images

The image-capture process is an intuitive, split-second operation for experienced users. By following basic guidelines, however, 
new users can easily develop their own technique and, with practice, quickly learn to adapt to different application environments.

Image Preview

When the imaging process is initiated, the touch screen displays a preview of the object. This is a live video image 
of what the imager is currently viewing and has a slightly degraded appearance compared to the captured image. 
This is normal; the captured image has a higher resolution.

File Formats

The Dolphin terminal is capable of saving images in a number of industry-standard file formats such as *.bmp, *.jpg 
and *.png. The default file format for images is a grayscale *.jpg. To obtain the highest quality images, take 
grayscale images.

File Size

Digital images have a maximum image size of 640 x 480 pixels and may have up to a 256 grayscale image 
definition. The image quality and related file size are determined by the data compression method used by the 
software application used to take the image. The average size of the image file is approximately 4–8K. However, 
the size of the image depends on image content, the more complex the content, the larger the file size. 

Taking an Image
1. Tap Start > Demos > Image Demo.

2. Point the Dolphin 7600 terminal at the object.

3. Press the scan trigger to activate the engine. The touch screen displays a preview of the object.

4. Adjust the terminal’s position until the preview on the screen appears as you want it to appear in the image.

5. Hold the terminal still and release the Scan trigger. The touch screen flashes, and the captured image appears on the 
screen. 

6. By default, the image is saved to the My Device folder (Start > Programs > File Explorer > My Device). 
To save the image to another location, tap File > Save As.

High-Vis Aiming Pattern
If your Dolphin terminal is configured with the 5300SF/SR/HD imager, you can enable the aiming pattern for imaging in the Image 
Demo application.

1. Tap Start > Demos > Imaging Demo > Options menu > Aimer.

2. The aiming pattern is now enabled for imaging.

Uploading Images
Image files can be transmitted to a host workstation via 

• Microsoft ActiveSync and a Dolphin communication peripheral, or 
• Over your wireless radio network.
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Communication
Communication Options

Dolphin terminals offer several communication options including Microsoft ActiveSync, infrared, and wireless radios.

I/O Connector
The mechanical connector on the bottom panel (see I/O Connector on page 3-8) connects the terminal to various Dolphin 
communication peripherals that connect to a host workstation via USB (1.1 or higher), thus enabling ActiveSync communication.

For more information about communicating with ActiveSync, see ActiveSync Communication on page 6-4.

Wireless Radios
Dolphin 7600 terminals can be equipped with an 802.11b/g or Bluetooth radio or a combination of these radios. When the 
terminal’s radios are enabled, you can connect the terminal to a wireless network for communication.

IrDA Port
The IrDA port enables the Dolphin 7600 to transmit data via pulses of infrared light to and from other IrDA-compliant devices, 
such as printers, workstations, and even other Dolphin terminals. 

For more information about communicating via the IrDA port, see Using Infrared???? on page 6-10. 

Software Communication Programs
Dolphin terminals are shipped with the following communication software programs installed.

Microsoft ActiveSync v3.7 or Higher

Microsoft ActiveSync is a tool that enables mobile computing devices to exchange and synchronize application data 
with a desktop computer. For more information, see ActiveSync Communication on page 6-4.

Remote Access Services (RAS)

RAS is a feature built into Windows NT that enables users to log into an NT-based LAN using a modem, X.25 
connection or WAN link. RAS is fully supported and allows the use of Point-to-Point Protocol (PPP) or Serial Line 
IP (SLIP) connections for network connectivity.

To establish a RAS connection, set the terminal up on a wireless network, then activate the RASMan Power Tool 
by tapping Start > Power Tools > RASMan. 

For more information about Power Tools, refer to the Dolphin Power Tools User’s Guide, which is available for 
download from www.handheld.com.
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Default Com Port Assignments

The Dolphin terminal ships with the com ports assigned as follows: 

Installing Additional Software

Dolphin terminals ship with the operating system, radio drivers, and custom Hand Held Products software loaded onto the device. 
These are the default programs that install when your terminal first boots up. You can install additional software programs to the 
terminal provided that the following parameters are met:

• the software program was created for a Windows Mobile device.
• The terminal has enough memory to store and run the program.
• The program has an *.exe, *.cab, or *.dll extension. 

The most popular place to find software on the Windows Mobile website: www.microsoft.com/windowsmobile/products/pocketpc/

When selecting programs, verify that the program and version of the program are designed for the Windows Mobile 2003 
Second Edition and the terminal’s processor. You can verify your processor by tapping Start > Settings > System tab > 
About > Version tab. Make a note of the information in the Processor field. 

To install additional software, you can use the communication options described in this chapter.

• Adding Programs via ActiveSync, page 6-7.
• Adding Programs via the Internet, page 6-9.
• Adding Programs via Infrared, page 6-11

Com 
Port

Assignment

1 Serial port; this is the 17-pin mechanical connector on the bottom panel. 
See I/O Connector on page 3-8.

2 Bluetooth Module 
If there is no Bluetooth hardware installed on the terminal, this com port is unassigned.

3 Raw Infrared

4 Unassigned

5 USB virtual serial port

6 IrDA, if IrDA is enabled. If IrDA is disabled, this com port becomes available. 
See Verify That the IrDA Port is Enabled on page 6-10.

7, 8, & 9 Unassigned
These are virtual com ports that are available for selection only when connecting to devices that 
use virtual com ports, such as Bluetooth.

!
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Connecting the USB Cable

Connect the USB cable to the I/O connector to facilitate USB communication between the Dolphin device and host workstation.

This is a communication-only cable. 

*The power port on the back end of the USB connector fits the power cable that comes with each Dolphin 7600 device. To charge 
the device while communicating, connect the power cable to the power port.

USB 
Cable

I/O 
Connector

Host 
Workstation

*Power 
Port

USB 
Connector
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ActiveSync Communication

To synchronize, ActiveSync 3.7 or higher must be installed and configured for the appropriate communication type on the host 
workstation and the Dolphin terminal. Dolphin terminals ship with ActiveSync already installed. Therefore, if ActiveSync is already 
installed on the host workstation, you just need to connect the Dolphin terminal to the host workstation (via Dolphin peripheral) 
to initiate communication.

If ActiveSync 3.7 or higher is not installed on the host workstation, install it from the Microsoft Companion CD that came with the 
Dolphin terminal. Insert the CD into the CD-ROM drive of the host workstation and click the yellow arrow, then Start Here, and 
follow the directions on your screen.

Note: You can also download the most current version of ActiveSync from www.microsoft.com and install.

When communicating via ActiveSync, your terminal must be connected to the host workstation with a communication peripheral  
sold/manufactured by Hand Held Products, such as the Dolphin HomeBase or Dolphin Charge/Communication cable. Use of any 
peripheral not sold/manufactured by Hand Held Products may damage your terminal and will void the warranty.

Communication Types
The Dolphin 7600 supports the following types of communication via ActiveSync through its I/O Connector (see page 3-8) on the 
bottom panel:

USB The USB cable and hardware peripherals allow the Dolphin terminal to communicate with a 
workstation or to networked through a USB hub. The Dolphin terminal supports full-speed USB 
communication (USB 1.1); maximum data transfer rate is 12 Mbps. The Dolphin terminal defaults to 
USB communication out of the box.

RS-232 The RS-232 cable allows the Dolphin terminal to communicate with a workstation, modem, or any 
RS-232 device. Maximum data transfer rate is 115 Kbps.

Required Equipment for Setup
• Dolphin HomeBase or Dolphin communication cable 
• Power Adapter Cable from Hand Held Products
• USB Cable
• Serial Cable (for RS-232)
• ActiveSync v3.7 or higher installed on the host workstation

• Windows® 98 Second Edition*, Windows® Me, Windows® 2000, or Windows® XP computer. 

Note: The Dolphin HomeBase does not support Windows NT® when using a USB connection. This is because Windows NT does 
not support USB. *Windows® 98 second edition provides full USB support.

USB Communication
The Dolphin terminal defaults to USB communication out of the box. To sync successfully, ActiveSync must be configured for 
same communication type on both the host workstation and the Dolphin terminal. ActiveSync must be setup on your desktop 
computer before you initiate synchronization from the terminal for the first time.

Setting up the Terminal for USB Communication
1. On the terminal, tap Start > ActiveSync > Tools > Options. ActiveSync opens displaying the PC tab.

2.  In the Use this PC drop-down list, select the name of the host workstation.

!
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3. Select Sync with this PC during manual sync to indicate that the terminal syncs with the selected host workstation when 
synchronization is run from the terminal.

4. Tap Options.

5. Select Enable PC sync using this connection, and select ‘USB Connection from the drop-down list.
The default workstation synchronization value for USB communication is ‘USB Connection. 

6. Tap OK and place the Dolphin in the HomeBase. The Dolphin terminal attempts to start an ActiveSync connection with the 
workstation automatically.

Setting up the Host Workstation for USB Communication
Verify that ActiveSync on the workstation has selected the appropriate communication type by clicking File > Connection 
Settings.

The Allow USB connections box must be checked.

RS-232 Communication
ActiveSync must be installed and configured for RS-232 on the desktop computer to sync successfully with a Dolphin terminal 
that is configured for RS-232 communication. 

Setting up the Terminal for RS-232 Communication
1. On the terminal, tap Start > ActiveSync > Tools > Options. ActiveSync opens displaying the PC tab.
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2.  In the Use this PC drop-down list, select the name of the host workstation.

3. Select Sync with this PC during manual sync to indicate that the terminal syncs with the selected host workstation when 
synchronization is run from the terminal.

4. Tap Options.

5. Select Enable PC sync using this connection, and select ‘115200 Default from the drop-down list. 
‘115200 baud is the default and what’s recommended for RS-232 communication. 

6. Tap OK and place the Dolphin in the HomeBase. The Dolphin terminal attempts to start an ActiveSync connection with the 
workstation automatically.

Setting up the Workstation for RS-232 Communication
Open ActiveSync and click File > Connection Settings.

Note: You can have the USB connection box checked in addition to the serial cable box without affecting processing. However, 
you should use RS-232 or USB.

Communicating with the Dolphin Terminal

After setting up both the workstation and the terminal, ActiveSync connection should be automatic.

1. Connect the Dolphin terminal to the a communication peripheral, such as the Dolphin HomeBase. 

2. The Dolphin terminal automatically opens ActiveSync to establish a connection.
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Synchronizing with the Host Workstation
After setup, synchronization begins automatically whenever the terminal’s mechanical connector connects to a Dolphin 
peripheral that is connected to a host workstation with ActiveSync installed. 

Note: If you have a wireless LAN card, you can also synchronize remotely. 

Exploring the Terminal from the Workstation
When the terminal and desktop computer are connected, open the main ActiveSync window (on the desktop), and click Explore.

The Mobile Device folder opens in Windows Explorer. 

The Dolphin terminal is now treated as a mass storage device, and transferring files is as simple as dragging and dropping or 
copying and pasting as you would for moving files between folders on your hard drive.

Adding Programs via ActiveSync
When selecting programs, verify that the program and version of the program are designed for Windows Mobile 2003 Second 
Edition and your processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make 
a note of the information in the Processor field. 

Generally, software for Windows Mobile devices must be installed to the host workstation first, then transferred to the Dolphin 
terminal. 

1. Download the program to the workstation from either the Internet or the install CD. You may see a single *.exe or setup.exe 
file, a *.cab file, or *.dll. (There may also be several versions of files for different device types and processors.)

2. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

3. Connect the terminal to the workstation via Hand Held Products communication peripheral.

If the File is an Installer

An installer program is one that installs to the workstation and the terminal simultaneously; one process installs to both devices.

1. On the workstation, double-click the *.exe or *.setup.exe file. The installation wizard begins. 

2. Follow the directions on the workstation screen. The installation process includes transferring the software to the terminal 
via ActiveSync. 

If the File is Not an Installer

Some programs cannot be installed on workstations because they are designed exclusively for Windows Mobile devices. In these 
cases, the appropriate files must be stored on the host workstation and transferred to the terminal via ActiveSync Explore. 

Note: You know that the program is not an installer because an error message stating that the program is valid but designed for 
a different type of computer appears when you try to install the program on the workstation. 

1. If you cannot find any installation instructions for the program in the Read Me file or documentation, open ActiveSync and 
click Explore.

!
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2. Navigate to the My Pocket workstation folder and copy the program file or files to the Program Files folder on the terminal. 
If you want the program to be part of the Autoinstall that occurs after every hard reset, place the program file in the 
Autoinstall folder (\\IPSM\AutoInstall).

3. On the terminal, tap Start > Programs > File Explorer and navigate to the folder where the program is located.

4. Tap on the program file to install it.
If you copied the file to the Autoinstall folder, you can choose to install the program by performing a hard reset. The 
program installs as part of initialization. 

5. After installation is complete, access the program by tapping Start > Programs and the program appears on the Programs 
screen. Tap the icon to open the program.

For Additional Help
You can find more information on the host workstation by clicking Help > Microsoft ActiveSync Help.

You can find more information on the terminal by tapping Start > Programs > Help > ActiveSync.

For more information, go to the Windows Mobile software website at:  www.microsoft.com/windowsmobile/products/pocketpc/
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Connecting the Terminal to a Wireless Network

Establishing the terminal on a wireless network depends heavily on your network infrastructure. You will need specific information 
from your network administrator.

Whatever your network specifics, some general steps apply:

1. The on-board radio drivers must be enabled for the terminal to transmit a signal. 

2. Enter the appropriate configuration settings for each radio installed. Each radio has its own configuration program.

• For details about 802.11b/g configuration, see WLAN Manager–802.11b/g on page 8-1.
• For details about Bluetooth configuration, see Bluetooth Manager on page 7-1.

Adding Programs via the Internet

When you have established a network connection (whether via modem or wireless radio), you can access the Internet and 
download additional software programs.

When selecting programs, verify that the program and version of the program are designed for the Windows Mobile 2003 Second 
Edition and the terminal’s processor. 

1. Verify the terminal’s processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the 
information in the Processor field. 

2. Open Pocket Internet Explorer and navigate to the program’s location. You may see a single *.exe or setup.exe file, or 
several versions of files for different device types and processors. 

3. Select the program version that matches your Dolphin terminal and processor. 

4. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

5. Download the program to the terminal straight from the Internet.
You would normally store the program in the \Program Files folder unless another location is required by the program. 

6. On the terminal, tap the installer file, such as an *.exe file.

7.  The installation wizard for the program begins. 

8. Follow the directions on the screen to complete installation.

Server-Assigned IP Addresses
Please note that all server-assigned IP addresses use Dynamic Host Configuration Protocol (DHCP).

Zero-Config Wi-Fi
Please note that the zero-config Wi-Fi feature of Windows Mobile is disabled on Dolphin terminals.

!
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Using Infrared????

CAN’T FIND SCREENS

The IrDA port sends and receives data between the terminal and other devices equipped with infrared. The maximum data 
transfer speed is 115 Kbps.

IrDA Port Location 

Verify That the IrDA Port is Enabled
The IrDA port must be enabled to transmit data. By default, the IrDA port is assigned to COM port 6 and is enabled. 

When a Bluetooth radio is installed, however, you have the option of disabling the IrDA port.

Note: If you do not have a Bluetooth radio installed, your IrDA port is always enabled.

Tap Start > Settings > Connections tab > IrDA.

If Enable IrDA ports is selected, then the IrDA port is active.

Select Disable IrDA ports to disable the IrDA port (com port 6).

Verify Beam Settings 
The Beam Settings must be set to receive for the terminal to receive data from other infrared devices. To verify, tap Start > 
Settings > Connections tab > Beam.  

Receive all incoming beams… must be checked for the terminal to receive infrared data from another device.

Sending Data 
You can send and receive information via infrared, including software programs (.exe files).

To send or receive, the IrDA ports of both devices must be aligned with each other and within a close range. The maximum data-
transfer speed is 115 Kbps.

1. Align the IrDA ports of both devices.
When sending data from one Dolphin terminal to another, position both terminals so that the IrDA ports are facing each 
other directly.

2. Open the program where you created the item you want to send and locate the item in the list.
You can beam files, but not folders, from File Explorer. 

3. Tap and hold the item. A pop-up menu appears. 

4. Select Beam File. The information begins transmitting to the other infrared device.

Receiving Data
1. Verify that the terminal is set to receive all incoming beams; see Verify Beam Settings on page 6-10.

2. Align the IrDA ports.

3. Have the owner of the other device send the information to you via infrared. 

IrDA Port
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4. Your terminal automatically begins receiving it.

Adding Programs via Infrared
Use send and receive to load additional software programs in terminals.

Troubleshooting
If the Beam Settings are not set to receive or you’ve aligned two IrDA ports and the terminal is still not receiving, go to Start > 
Programs > Infrared Receive. The terminal searches for the sending device. 

If the terminal cannot find the sending device, the following message appears:
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7

Dol
Seco
Bluetooth Manager
Overview

Each Dolphin 7600 contains a Bluetooth radio whose driver installs each time the device boots up.

Configuring the Bluetooth Radio

Tap the Bluetooth icon in the command bar  or

Tap Start > Programs > Bluetooth Manager.

Complete the tab windows to set up the radio. Use the left and right arrows on the upper right corner to scroll through the tab 
windows. 

Setting Tab

Field Description

Power This setting enables and disabled the radio. By default, the Bluetooth radio is enabled 
after each hard reset.

BT Device ID

Address The MAC address from the radio driver.

Name The first time you open the Bluetooth manager, the default name of the Dolphin device 
appears. You can change the name here. 

Rename Click this button to clear the Name field and type in a unique name for the Dolphin device.
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Pair Tab

The Pair tab enables you to find and pair with a local Bluetooth device.

Searching for Bluetooth Devices
1. On the Pair tab, tap Search Device. The Dolphin begins searching for compatible Bluetooth devices.

2. When the search is finished the found devices appear.

Field Description

Field This box displays found Bluetooth devices.

Delete Device Deletes a selected device in the field above.

Search Device Searches for Bluetooth devices in the area.
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3. To pair with one of the found devices, double-tap on the device. The device may ask you to authenticate by entering a 
password. 

4. Enter a PIN number and tap OK.

5. On the found device, accept the Authentication Request.

6. The new item appears on the window displaying the MAC address.

Serial Port Tab

On the Serial Port tab, you can register paired devices as a client of the Dolphin or register the Dolphin as client of a Bluetooth 
device designated as a server.

Field Description

Registered Bluetooth Serial Ports

This list contains the current COM ports in use.

Port Name Displays the name of the port (e.g., COM1–COM9).

Role Identifies the COM port as a server or client COM port.

Server Address For client ports, this field displays the server address.

Register New Server Port Tap this button to register the Dolphin device as a client of a Bluetooth server device.

Register New Client Port Tap this button to register a paired device as a client port. The new port appears in the list.

Deregister Serial Port Select a port in the list and tap this button to deregister the port. This frees up a COM 
port. 
Dolphin® 7600 Series User’s Guide -
Second Draft Preliminary

Rev (a) 7 - 3



FTP Sync Tab

The FTP Sync tab transfers files between the Dolphin and its paired devices and establish ActiveSync settings. 

Transferring Files
1. On the FTP Sync tab, tap Beam File.  

2. Tap the  button to browse for a file to transfer.

3. Navigate to the file location, select the file, and tap OK.
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4. Select the device in the list and tap Tab to Send. The file begins sending.

5. When the file is sent, the FTP Sync window appears again.

ActiveSync Settings
The ActiveSync Settings section of the FTP Sync tab window enables you to setup ActiveSync communication with Bluetooth.

Tap Options to see the ActiveSync settings. 

The Bluetooth ActiveSync settings default to the current Microsoft ActiveSync settings. 

To change the connection settings, tap Change Connection, and select new parameters.
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To manually sync via ActiveSync, tap Sync.
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Dol
Seco
WLAN Manager–802.11b/g
Overview

The Dolphin 7600 has an optional 2.4 GHz 802.11b/g WLAN (Wireless Local Area Network) radio that uses Direct Sequence 
Spread Spectrum (DSSS) technology. The radio is interoperable with other 802.11b Wi-Fi-compliant products including Access 
Points (APs), PCs via PC card adapters and other wireless portable devices.

Speeds???
If, 
#  802.11b - 11 Mbps, 2.4 GHz
# 802.11g - 54 Mbps, 2.4 GHz 

How do we describe the speed of transmission on a b/g radio?
http://en.wikipedia.org/wiki/IEEE_802.11#802.11g
802.11b
Release Date Op. Frequency Data Rate (Typ) Data Rate (Max) Range (Indoor)
1999 2.4 GHz 6.5 Mbit/s 11 Mbit/s 30 Metres

802.11g
Release Date Op. Frequency Data Rate (Typ) Data Rate (Max) Range (Indoor)
2003 June 2.4 GHz 25 Mbit/s 54 Mbit/s 30~ m

In June 2003, a third modulation standard was ratified: 802.11g. This flavour works in the 2.4 GHz band (like 802.11b) but 
operates at a maximum raw data rate of 54 Mbit/s, or about 24.7 Mbit/s net throughput like 802.11a. 802.11g hardware will 
work with 802.11b hardware. Details of making b and g work well together occupied much of the lingering technical pro-
cess. In older networks, however, the presence of an 802.11b participant significantly reduces the speed of an 802.11g net-
work. The modulation scheme used in 802.11g is orthogonal frequency-division multiplexing (OFDM) for the data rates 
of 6, 9, 12, 18, 24, 36, 48, and 54 Mbit/s, and reverts to (like the 802.11b standard) CCK for 5.5 and 11 Mbit/s and 
DBPSK/DQPSK+DSSS for 1 and 2 Mbit/s. Even though 802.11g operates in the same frequency band as 802.11b, it can 
achieve higher data rates because of its similarities to 802.11a. The maximum range of 802.11g devices is slightly greater than 
that of 802.11b devices, but the range in which a client can achieve full (54 Mbit/s) data rate speed is much shorter than that of 
802.11b.
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WLAN Manager

The WLAN Manager configures the 802.11b/g radio.

In the command bar at the bottom of the window, double-tap the WLAN Manager icon . (The “X” appears over the icon when 

the radio is not configured.) The menu appears . Select Open. The WLAN Manager opens 
displaying the Status tab.

Status Icons
The WLAN Manager used several icons to indicate radio states.

Icon Description

Excellent signal strength. Excellent connection.

Poor signal strength. Poor connection.

Radio disabled. No radio connection. 

(Access Point) AP Mode.

Peer Station, Peer-to-Peer Mode.

WEP enabled. Network needs a WEP Key to connect.

WEP disabled. Network does not need a WEP Key to connect.

Mismatched WEP Key configuration with your network.

Online help button.
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Status Tab
The Status tab displays the current operating parameters of the 802.111b radio.

Field Description

Current Channel Shows the RF channel currently used by the radio.

Current TX Rate Shows the current transmit rate. This can be 1 Mbps, 2 Mbps, 5.5 Mbps, or 11 Mbps.

Disable/Enable 
Radio

Tap this button to disable/enable the radio.

Rescan Tap this button to start a rescan process to search for an AP with a stronger signal in the network.

Link Quality Displays the signal to noise ratio.

Strength Displays the signal strength at the receiver.

IP Address Displays the IP address of the radio. Verify configuration information with your network administrator. 

Renew IP Tap this button to reapply the IP address from the DHCP server when automatic DHCP is enabled.

State Displays the Network Name and the MAC address of the: 

• AP the radio is associated with in AP mode, or
• Creator of IBSS into which the radio is joined in peer-to-peer (Ad-Hoc) mode.

After an SSID is chosen, this field name changes to “BSS ID.”

More Info Tap this button to display detailed TCP/IP information as shown in the following screen.

Ping Tap this button to open the Ping Utility window where you can ping IP addresses.
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Config Tab
The Config tab provides a list of all APs and peer stations in range. Use the list to create and edit SSID profiles for APs that you 
want the terminal to associate with. 

Preferred Profiles SectionDisplays a list of your preferred profiles, the profiles you create or add from the list of Active SSIDs 
below. When applied, the 802.11b radio searches for the APs in the exact order shown in the list of 
profiles. This section is blank after the initial installation and each hard reset. This section remains 
blank if no automatic association preference is selected.

This section contains several icons that enable you to add and configure APs.

Active SSIDs This table shows all APs or peer stations (creator of IBSS) in the vicinity of the terminal that accept 
broadcast associations.

Each record displays information in the following six columns (Scroll right to see all the columns.): 

Icon Name Description

New Always active, tap this button to create a new profile. This opens the The 
Network Profile tab establishes the basic parameters of the network 
profile. Access the Network Profile tab by double-tapping on a network 
profile in the list on the Config tab or by tapping the New button  on the 
Config tab. (see page 8-6).

The following buttons activate only when an Active SSID in the Preferred Profile list is selected.

Edit Opens the configuration screens for a selected SSID in the Preferred 
Profiles list.

Delete Deletes the selected SSID from the Preferred Profile list.

Up Moves the selected SSID up one place in the Preferred Profile list so that 
the terminal hits it prior to the next SSID.

Down Move the selected SSID down one place in the Preferred Profile list so 
that the terminal hits it after the prior SSID.

Note: Remember that the terminal accesses the SSIDs in this list in the exact order that they 
appear; moving an SSID up or down in the list determines the order of contact.

Column This column displays…

SSID The Network Name of the AP or peer station and shows the signal strength icon 

.

Signal Strength in percentage for the selected SSID.
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Add        Tap this button to add an Active SSID to the Preferred Profiles list. Select and active SSID in the list, 

tap Add, and the profile moves to the Preferred Profiles list.

Apply Tap Apply to associate your station with a selected SSID. The SSID selected can be in the Preferred 
Profile or Active SSIDs lists. When applied, the Status tab opens displaying the status of the wireless 
connection. If the association fails, a search for another AP in the Preferred Profile list automatically 
takes place, and the radio attempts to associate with the station, in order of preference.

Refresh Tap Refresh to start a new search for all available APs or peer stations in the vicinity.

To Add an Active SSID to the Preferred Profile Table
An SSID needs to be in the Preferred Profile list to be edited.

1. Select an SSID in the Active SSID list and tap Add. The SSID moves to the Preferred Profile list.
If the SSID has the WEP Key turned on, the Settings window displays and prompts you to enter the WEP Method, Encryp-
tion Key, and Key ID. 

2. In the Preferred Profile list, select the SSID and tap Edit .

3. Follow the same process for creating a profile.

4. When configuration is complete, tap OK. 

5. The SSID and its profile are added into the Preferred Profiles list. 
If you’re adding an SSID with the WEP Key turned off, the Settings window does not display and the SSID is added directly 
to the Preferred Profile table. 

To Create a New Profile

In the Preferred Profiles section, tap the New button . Complete the Network Profile and Authentication tab windows.

Mode The mode of operation 

=AP

=Peer station

Channel The channel and applied WEP method, if any. 

=WEP Key-On 

=WEP Key-Off 

SupRate Supported data rate of the AP or the peer station.

BSSID 
(MAC Addr)

BSSID or MAC Address of the AP or the peer station.

Column This column displays…
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Network Profile Tab 
The Network Profile tab establishes the basic parameters of the network profile. Access the Network Profile tab by double-

tapping on a network profile in the list on the Config tab or by tapping the New button  on the Config tab.  

Authentication Tab
On the Authentication tab, you configure authentication and encryption. 

Field Description

Profile Name Enter the profile name·

Network Name &Type

SSID Enter an SSID, which is the Network Name. Check with your network administrator for Network Name 
(SSID).

TX Rate Choose the transmit rate from the drop-down list - 1MB, 2 MB, Auto 1/2 MB, 5.5 MB, 11 MB, or Fully Auto. 
The transmit rate is set to Fully Auto by default. 

Type From the drop-down list, select

Peer-to-Peer – This mode used for communication between two (or more) radio stations (cards) without 
an AP. 

Access Point (AP) – This mode is also called “Infrastructure” mode. 

Note: The SSID, Type, TX Rate, and Channel fields are unchangeable in AP mode, whereas TX Rate and Channel fields 
can be changed in Peer-to-Peer mode.
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To use WEP, the encryption key must be configured as part of the profile before connecting. For more information about 
configuring a profile, see To Create a New Profile on page 8-5.

Encryption Tab
The Encryption tab configures the WEP Parameters.

Field Description

*Authentication 
Algorithm

This drop-down list is active and configurable only when the WEP Key is enabled for the selected 
SSID profile. If this drop-down list is active, select one of the following options:
Open (This is the default selection.)

Shared

Encryption Select the encryption type:
Disabled for no encryption

WEP to use WEP encryption

Enable 802.1X This option and drop-down list is active only when the WEP Key is enabled.

Properties Tap to choose the certificate that applies. Accessing 802.1x networks require personal certificates for 
authentication. 

Field Description

Method The options in this drop-down list determine what characters can be used to create the WEP 
encryption key in the Encryption Key field. Select one of the following five:

• Disabled – WEP Key is off
• 64 bit (HEX) uses 10 characters in Hexadecimal
• 64 bit (ASCII) uses 5 characters in ASCII 
• 128 bit (HEX) uses 26 characters in Hexadecimal 
• 128 bit (ASCII) uses 13 characters in ASCII 

HEX – Hexadecimal is a set of 16 characters from 0-9 and from A(a)-F(f).
ASCII – Any printable ASCII character can be typed.

Key 1–4 Enter the WEP keys.
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Advanced Tab

Field Description

Power Save Mode This drop-down list determines the settings for Power Save Mode.

Disable – Disables the Power Save mode.

Always Enable – Enables Power Save mode. This is the default setting.

Preamble Mode A preamble consists of a Synchronization (Sync) field and a 16-bit Start Frame Delimiter (SFD) field.

Long TX Preamble – Where Sync field consists of 128 bits. 

Short TX Preamble – Where Sync field consists of 56 bits.

Auto TX Preamble – Automatically changes between long and short preamble mode transmission 
based on AP configurations. This is the default Preamble Mode.

Defaults Resets all the settings to default values, which are: 

• Always Enable for Power Save Mode, 
• Automatic based on WEP setting for Authentication Algorithm, and 
• Auto TX Preamble (for Preamble Mode).

Apply Applies changes. This button is active only when a change has been made on the tab.
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Dolphin HomeBase
Overview

As the hub of your Dolphin 7600 system, the Dolphin HomeBase charging and communication cradle supports full-speed USB 
1.1 communication with a workstation. 

Battery Charging
The HomeBase completes a full charge of the main battery pack in less than four hours. 

In addition to charging, the HomeBase powers the intelligent battery charging system in the terminal that protects the battery 
from being damaged by overcharging. The terminal senses when a battery pack is fully charged and automatically switches to a 
trickle charge that maintains the battery at full capacity. 

As a result, Dolphin terminals may be stored in the HomeBase indefinitely without damage to the terminals, battery packs, or 
peripherals. 

Communication
With USB port, the data transmission rate goes up to 12 Mbps. 

HomeBases cannot be physically connected to each other–sometimes referred to as “daisy-chaining”–but can be networked 
together via serial or USB hubs.

Convenient Storage 
The battery charging system makes the HomeBase a safe and convenient storage receptacle for your Dolphin terminal.

Capacity
The HomeBase holds one Dolphin 7600 terminal and charges its battery pack. 

Power Supply
The power cable that ships with each unit (see Charge the Batteries on page 2-2) also powers the Dolphin HomeBase.

Use only the peripherals, power cables, and power adapters from Hand Held Products. Use of peripherals, cables, or power 
adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

!

!
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Front Panel 

Terminal Well 

Place the Dolphin terminal in this well to communicate with a host device, power the terminal, and charge its battery 
pack. The back of the terminal well features a saddle that fits the integrated pistol-grip handle of the Dolphin 7600 
terminal. 

Dock LED   

Turns solid green when the Dolphin terminal is properly seated in the Dolphin HomeBase. When this light is on, the 
terminal is connected to the Dolphin HomeBase.

Rubber Feet

 The bottom panel has four rubber feet–one at each corner–to stabilize the unit on a flat surface. Set the Dolphin 
HomeBase on a dry, stable surface, such as a desktop or workbench near an electrical outlet.

Terminal Well

Dock LED
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Back Panel 

Pivot Connector

This pivoting connector swivels 90 degrees. The default position is horizontal, with the connectors facing straight 
out from the back panel. The pivoting stops in this position and again in the vertical position, with the connectors 
facing out the bottom panel.

DC Power Jack 

Connect the power cable to this power jack; see Powering the Dolphin HomeBase on page 9-3.

USB Port

This USB port is full-speed (v1.1).  Using the USB cable, you can connect the HomeBase to a USB-compliant device 
to facilitate USB communication to and from the terminal. USB communication occurs through Microsoft ActiveSync 
(v.3.7 or higher). For more information about ActiveSync setup, see ActiveSync Communication on page 6-4. 

Bottom Panel

Powering the Dolphin HomeBase

The terminal requires 5 volts DC input for communication and battery charging; the power adapter on the power cable converts 
the voltage from the power source to 5 volts DC. Only power adapter cables from Hand Held Products convert the voltage 
appropriately.

DC Power Jack USB Port

Pivot Connector

ITEM /
MODEL

#

S/N #

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appareil numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.

www.handheld.com

N10410

HomeBase
TM

5V DC IN

INPUT: 5 VDC @ 3A
OUTPUT: 5 VDC @3A

Made in Taiwan

7D21

E153740

Scheme

MIC
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The same power cable that ships with each terminal can be used to power the HomeBase. This cable contains a plug adapter 
for each geography (US, UK, EU, etc.).    

1. Attach the appropriate plug adapter to the power adapter.

2. Plug the power cable into the power source.

3. Plug the connector into the DC power jack on the back panel. The Dolphin HomeBase is now powered. 

When a terminal is properly seated in the terminal well, the Dolphin HomeBase powers the terminal, charges the terminal’s main 
battery pack, and launches ActiveSync (see ActiveSync Communication on page 6-4).

Hand Held Products recommends that you leave the Dolphin HomeBase connected to its power source at all times, so that it is 
always ready to use.

Charging the Main Battery

The Dolphin HomeBase powers the terminal and fully charges its main battery pack in less than four hours. To check battery 
power, see Power on page 6-11. 

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage.

Inserting a Terminal
1. Install the battery pack in the terminal; see Install the Main Battery on 

page 2-1.

2. Power the Dolphin HomeBase; see Powering the Dolphin HomeBase 
on page 9-3.

3. Slide the terminal into the terminal well until the Dock LED lights green 
to indicate that the terminal is properly seated.

4. The battery pack begins charging. 

1

Power Adapter

Plug Adapter

Power Cable
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Mounting the Dolphin HomeBase

If you want to mount the HomeBase to a vertical surface, be sure to provide enough workspace with good lighting for the user to 
view and operate the Dolphin terminal while it is in the HomeBase. Use the screws appropriate to the vertical surface you are 
mounting to.
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Back Panel Dimensions
.15 in.
(3.85 m

m
.)

1.44 in.
(36.7 m

m
.)

3.99 in.
(101.42 m

m
.)

1.84 in.
(46.87 m

m
.)

4.35 in.
(110.47 m

m
.)

.32 in.
8.06m

m
 D

iam
eter, 

2 places

.53 in.
13.65m

m
,

2 places
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Bottom Panel Dimensions

Note: The pivot connector should be facing straight out the bottom panel (as shown) when mounting the HomeBase to a vertical 
surface.

  

3.73 in.
(94.88 mm.)

.55 in.
(14.07 mm.)

.67 in.
(16.97 mm.)
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Dolphin HomeBase Technical Specifications
Structural

Dimensions ?" high X ?" wide X ?" deep (? X ? X ? cm)

Weight ???

Material Case: Polycarbonate ABS blend

Color Gray

Environmental

Operating Temperature 32° to 122°F (0° to 50°C)

Storage Temperature -4° to 158°F (-20° to 70°C)

Electrical Static Discharge 8 KVA immunity on all surfaces

Humidity Up to 95% non-condensing humidity

Power Supply

Input (Universal)
(from the power source)

100–250 Volts, 1.0 A, 50–60Hz
Power adapter converts the input voltage to the appropriate voltage for the HomeBase.
(p/n 41206341-01)

Output
(to the HomeBase)

5 Volts DC, 4.0 A

Input Connection 3 Position  IEC-320-C14

Charging

Standard Charge Completes 100% charge of Li-ion battery packs in four hours or less 

Max Charging Current 2A Max

Standby Current <100mA

DOCK LED See Dock LED on page 9-2.

Communication

Interface • USB B Male connector supports 12 Mbps communication
• RS-232 DB-9 Female connector supports up to 115 Kbps communication

Agency Approvals

Power Supply: UL listed, TUV licensed
Power Supply compliant to FCC part 15 Class B

Charging: CE Marking (EMC)

Fire Retardant: UL 94-VO 
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Dolphin QuadCharger
Overview

The Dolphin QuadCharger is a four-slot charging station that charges both 2200mAh or 3240mAh Li-ion battery packs in less 
than four hours. 

Battery Charging
Each slot works independently of the other three. As battery packs charge, the charging circuitry follows the two-step charging 
process (CC-CV) that is recommended for Li-Ion batteries. The process monitors changes in temperature, current, and voltage. 
The charger also resets and calibrates battery pack data to accurately show battery status on the Dolphin display.

Use only the peripherals, power cables, and power adapters from Hand Held Products. Use of peripherals, cables, or power 
adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal. 
Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or bat

Front Panel 

Charging Slots

The QuadCharger contains four charging slots. Each slot holds one battery. When a battery is placed in a slot, it 
immediately begins charging.   

Status LEDs

A status LED is located above each of the four battery slots. The color of the LED indicates the charge status of the 
batteries in its slot. 

Status LED color Description

Green (solid) The battery has completed its charge cycle and is ready for use.

Orange (solid) The battery is charging.

Red (flashing) The QuadCharger encountered an error during the most recent charge cycle.

!
!

Charging Slots

Status LEDs
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Back Panel

Power Switch

Toggle the power switch to turn the QuadCharger on and off. 

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input 
voltages between 90-265 volts.

Supplying Power to the QuadCharger

Use the power adapter cable that comes with the Dolphin QuadCharger so that the input voltage is adjusted appropriately.

1. Locate the AC power adapter cable and plug it into the power source. 

2. Connect the power cable to the power adapter.

3. Connect the power cable to the power supply connector on the back of the QuadCharger. 

4. Press the power switch to the ON position.

5. The device performs the following power-up diagnostic routine for each bay indicated by the Status LEDs.:

• All ON Orange
• delay (500ms)
• All ON Red
• delay (500ms)
• All ON Green
• delay (500ms)
• All OFF

Power Supply ConnectorPower Switch
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Bottom Panel

Inserting and Removing Battery Packs 

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. The Status LED for that particular slot illuminates orange when the battery has been 
properly inserted. To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a 
hinging motion.

Charging Batteries in the QuadCharger

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging. The recommended temperature range is 50° to 95° F (10°  to 35°  C). 

1. Supply the QuadCharger with power and turn the power switch on.

2. Insert batteries into the appropriate slots. The Status LED for each slot turns orange to indicate that the battery has begun a 
charge cycle.

3. When the Status LED turns green, the battery in the slot has completed charging.

Recommendations for Storing Batteries

To maintain top performance from batteries, follow these storage guidelines:

• Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

Mounting the QuadCharger

The Dolphin QuadCharger should be on a dry, stable surface. To easily adapt the QuadCharger to your environment, it can be 
mounted on a flat, horizontal surface such as a desktop or workbench, or a flat, vertical surface such as a wall using a DIN rail 
on the bottom panel. 

ITEM /
MODEL

#

S/N #

Made in Taiwan

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appareil numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

NO USER SERVICEABLE PARTS. OPENING VOIDS WARRANTY. USE AUTHORIZED
HAND HELD PRODUCTS, INC BATTERY PACK ONLY. OTHER TYPES OF BATTERIES MAY BURST 
CAUSING INJURY TO PERSONS AND DAMAGE. DO NOT CHARGE ALKALINE BATTERIES.
INDOOR USE ONLY. NICHT IM FRIEN BENUTZEN. NE PAS UTILISER a L’EXTERIEUR.

Hand Held Products, Inc.          www.handheld.com
TM

QuadCharger

INPUT: 12.0 VDC @ 2.5A
OUTPUT: 4.2VDC @ 1350 mA(4)

7D21

E153740
N10410
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Note: When choosing a location, always bear in mind that the mounting location must allow users easy access to power switch 
and power connector.

To mount the Dolphin QuadCharger, you slide the DIN Rail into the slot on the bottom panel. Then, using the appropriate nuts 
and bolts, secure the DIN rail to the desk or wall.  

Bottom Panel

DIN Rail

11 in. (278.93 mm.)

6.17 in. (156.8 mm.)

.99 in. 
(25.2 mm.)

.99 in. (25.2 mm.).13 in. (3.4 mm.)
1.17 in.
(29.7 mm.)

1.42 in.
(36 mm.)

4.78 in.
(121.4
mm.)

.13 in. 
(35 mm.)

.24 in. 
(6.3
mm.)

.98 in.  (25 mm.)
.7 in. (17.8 mm.)

.1 in. 
(27mm.)

.24 in. 
(3.6 mm.)

.04 in. (1 mm.)
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Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions. If problems persist, please 
contact Technical Assistance (see page 11-2). 

Problem Issue

The Status LED does not come on when 
I insert a battery pack into the Dolphin 
QuadCharger

Check the power connections on the Dolphin QuadCharger; make sure 
the POWER switch is ON and the battery pack is properly seated.

The Status LED lights red during 
charging.

Try to charge the battery in one of the other charging slots. If the red 
Status LED comes on again, then the problem is associated with the 
battery pack. If the red status stays with the charging slot, the problem is 
associated with the charging circuity.

The Status LED lights red and stays on 
without a battery in the charging slot.

An error occurred during the self-diagnostic test for that particular 
charging pocket. Call Hand Held Products Product Service and Repair 
(see page 11-1) to request an RMA.  
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Dolphin QuadCharger Technical Specifications
Structural

Dimensions 11in. long X 4.78 in. wide X ?? in. high (27.9 cm X 12.1 cm X ?? cm.)

Weight 18 oz. (510g)

Material Case:  Polycarbonate ABS blend

Color Blue/Gray

Mounting Use DIN rail slide to mount to a desktop or wall; see DIN Rail on page 10-4.

Capacity Supports 1 to 4 batteries

Environmental

Operating Temperature 14° to 122°F (-10° to 50°C) 

Storage Temperature -4° to 140°F (-20° to 60°C)

Electrical Static Discharge 8 KVA immunity on all surfaces

Humidity 90% relative humidity (non-condensing)

Power Supply

Input (Universal) 100V-240V (+/- 10%), 50-60Hz

Output 12Volts DC, 2.5 A

Input Connection 2 Position IEC 320-C8

Charging 

Standard Charge Completes 100% charge in four hours

Status LED See Status LEDs on page 10-1.

Agency Approvals

Power Supply UL listed (UL 1950), TUV licensed (EN60 950STD)
Power Supply compliant to FCC part 15 Class B 

Charging CE Marking (EMC); CISPR Pub 22, FCC Part 15 Class B

Fire Retardant UL94 V-0
10 - 6 Rev (a) Dolphin® 7600 Series User’s Guide
-Second Draft Preliminary



11
Dol
Seco
Customer Support
Product Service and Repair

Hand Held Products provides service for all its products through service centers throughout the world.  To obtain warranty or 
non-warranty service, return the unit to Hand Held Products (postage paid) with a copy of the dated purchase record attached.  
Contact the appropriate location below to obtain a Return Material Authorization number (RMA #) before returning the product.

North America

Hand Held Products Corporate Offices
Telephone:(800) 782-4263, option 3
Fax:  (704) 566-6015
E-mail:  naservice@handheld.com

América Latina

Hand Held Products América Latina
Teléfono:  (800) 782-4263, opción 8,  opción 4
Teléfono:  (704) 998-3998, opción 8, opción 4 
Fax:  (239) 263-9689
E-mail:  laservice@handheld.com

Brasil

Hand Held Products São Paulo
Teléfono:  Int+55 (11) 2178-0500
Fax:  Int+55 (11) 2178-0502

Hand Held Products Rio de Janeiro
Teléfono: Int+55 (21) 2178-0500
Fax:  Int+55 (21) 2178-0505

São Paulo and Rio de Janeiro
E-mail:  brservice@handheld.com

México

Hand Held Products México
Teléfono:  Intl+52 (55) 5203-2100
Fax:  Intl+52 (55) 5531-3672
E-mail:  mxservice@handheld.com

Europe, Middle East, and Africa

Hand Held Products Europe
Telephone:+31 (0) 40 29 01 633
Fax:  +31 (0) 40 2901631
E-mail:  euservice@handheld.com

Asia Pacific

Hand Held Products Asia/Pacific
Telephone:+852-2511-3050 
Fax:   +852-2511-3557
E-mail:  apservice@handheld.com

Japan

Hand Held Products Japan
Telephone:+81-3-5770-6312 
Fax:  +81-3-5770-6313 
E-mail:  apservice@handheld.com

Online Product Service and Repair Assistance
You can also access product service and repair assistance online at www.handheld.com.
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Technical Assistance

If you need assistance installing or troubleshooting, please call your Distributor or the nearest Hand Held Products technical 
support office:

North America/Canada:

Telephone: (800) 782-4263, option 4 (8 a.m. to 6 p.m.  EST)
Fax number: (315) 685-4960
E-mail: natechsupport@handheld.com

América Latina:

Teléfono: (800) 782-4263, opción 8, opción 3
Teléfono: (704) 998-3998, opción 8, opción 3
E-mail: latechsupport@handheld.com

Brasil

São Paulo
Teléfono: Int+55 (11) 2178-0500
Fax: Int+55 (11) 2178-0502

Rio de Janeiro
Teléfono: Int+55 (21) 2178-0500
Fax: Int+55 (21) 2178-0505

São Paulo and Rio de Janeiro
E-mail: brtechsupport@handheld.com

México

Teléfono: (800) 782-4263, opción 8, opción 3
Teléfono: (704) 998-3998, opción 8, opción 3
E-mail: latechsupport@handheld.com

Europe, Middle East, and Africa:

Telephone-
European Ofc: Int+31 (0) 40 79 99 393
U.K. Ofc: Int+44 1925 240055
E-mail: eutechsupport@handheld.com

Asia Pacific:

Telephone: Int+852-3188-3485 or  2511-3050  
E-mail: aptechsupport@handheld.com

Online Technical Assistance
You can also access technical assistance online at www.handheld.com.

Limited Warranty

Hand Held Products, Inc. ("Hand Held Products") warrants its products to be free from defects in materials and workmanship and 
to conform to Hand Held Products’ published specifications applicable to the products purchased at the time of shipment. This 
warranty does not cover any Hand Held Products product which is (i) improperly installed or used; (ii) damaged by accident or 
negligence, including failure to follow the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) 
modification or alteration by the purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface 
connections, (C) static electricity or electro-static discharge, (D) operation under conditions beyond the specified operating 
parameters, or (E) repair or service of the product by anyone other than Hand Held Products or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by Hand Held Products for the product at the time 
of purchase ("Warranty Period"). Any defective product must be returned (at purchaser’s expense) during the Warranty Period 
to Hand Held Products’ factory or authorized service center for inspection. No product will be accepted by Hand Held Products 
without a Return Materials Authorization, which may be obtained by contacting Hand Held Products. In the event that the product 
is returned to Hand Held Products or its authorized service center within the Warranty Period and Hand Held Products determines 
to its satisfaction that the product is defective due to defects in materials or workmanship, Hand Held Products, at its sole option, 
will either repair or replace the product without charge, except for return shipping to Hand Held Products.
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EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HAND HELD PRODUCTS’ RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS 
LIMITED TO THE REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT. IN NO EVENT SHALL HAND HELD 
PRODUCTS BE LIABLE FOR INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY 
LIABILITY OF HAND HELD PRODUCTS ARISING IN CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER 
SUCH LIABILITY ARISES FROM A CLAIM BASED ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE 
ACTUAL AMOUNT PAID TO HAND HELD PRODUCTS FOR THE PRODUCT. THESE LIMITATIONS ON LIABILITY SHALL 
REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HAND HELD PRODUCTS MAY HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES. SOME STATES, PROVINCES, OR COUNTRIES DO NOT 
ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

Hand Held Products extends these warranties only to the first end-users of the products. These warranties are non-transferable.

The limited duration of the warranty for the Dolphin 7600 is as follows:

• Terminals with an integrated imager are covered by a two-year limited warranty.
• Terminals with an integrated laser engine are covered by a one-year limited warranty.   
• Touch screens are covered by a one-year limited warranty.
• Dolphin HomeBase, Dolphin Mobile Mount, Dolphin ChargeBase, Dolphin Mobile Charger, and Dolphin QuadCharger are 

covered by a one-year limited warranty. 
• Use of any peripheral not manufactured/sold by Hand Held Products will void the warranty. This includes but is not limited to: 

cables, power supplies, cradles, and docking stations.
• Use only power adapters approved for use by Hand Held Products. Failure to do so may result in improper operation or 

damage to the unit and will void the warranty.
• Batteries are covered by a one-year limited warranty. Use of any battery not sold/manufactured by Hand Held Products may 

damage the terminal and/or the battery and will void the warranty. Batteries returned to Hand Held Products in a reduced state 
may or may not be replaced under this warranty. Battery life will be greatly increased when following the battery instructions 
in the Dolphin 7600 User’s Guide.

How to Extend Your Warranty
Hand Held Products offers a variety of service plans on our hardware products. These agreements offer continued coverage for 
your equipment after the initial warranty expires. For more information, contact your Sales Representative, Customer Account 
Representative, or Product Service Marketing Manager from Hand Held Products, or your Authorized Reseller. 
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